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Product notice

This user guide describes features that are 
common to most models. Some features may 
not be available on your computer.

Not all features are available in all editions of 
Windows. This computer may require upgraded 
and/or separately purchased hardware, drivers 
and/or software to take full advantage of 
Windows functionality. Go to 
http://www.microsoft.com for details.

Software terms

By installing, copying, downloading, or 
otherwise using any software product 
preinstalled on this computer, you agree to be 
bound by the terms of the HP End User License 
Agreement (EULA). If you do not accept these 
license terms, your sole remedy is to return the 
entire unused product (hardware and software) 
within 14 days for a full refund subject to the 
refund policy of your seller.

For any further information or to request a full 
refund of the price of the computer, please 
contact your seller.

http://www.microsoft.com


Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not place 
the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface. Do 
not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs 
or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as 
pillows or rugs or clothing, during operation. The device and the AC adapter comply with the user-accessible 
surface temperature limits defined by the International Standard for Safety of Information Technology 
Equipment (IEC 60950).
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1 Product features

Standard configuration features
Features may vary depending on the model. For support assistance and to learn more about the hardware 
and software installed on your computer model, run the HP Support Assistant utility.

CAUTION: Several well-known vulnerabilities exist when a computer is in the Sleep state. To prevent an 
unauthorized user from accessing data on your computer, even encrypted data, HP recommends that you 
always initiate Hibernation instead of Sleep anytime the computer will be out of your physical 
possession. This practice is particularly important when you travel with your computer.

Serial number location
Each computer has a unique serial number and a product ID number that are located on the exterior of the 
computer. Keep these numbers available for use when contacting customer service for assistance.
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Front panel components
Drive configuration may vary by model. Some models have a bezel blank covering the slim optical drive bay.

1 Dual-State Power Button 4 7-in-1 Media Card Reader

2 9.5-mm Optical Drive (optional) 5 USB 2.0 Port

3 Microphone/Headphone Connector 6 USB 2.0 Port

NOTE: When a device is plugged into the Microphone/Headphone Connector, a dialog box will pop up asking if you want to 
use the connector for a microphone line-In device or a headphone. You can reconfigure the connector at any time by 
double-clicking the Audio Manager icon in the Windows taskbar.

NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the 
computer and it is displaying a diagnostic code. Refer to Interpreting system validation diagnostic front panel LEDs and 
audible codes on page 81to interpret the code.
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Rear panel components

1 RJ-45 Network Connector 7 USB 3.0 Port

2 USB 2.0 Port 8 Power Cord Connector

3 USB 2.0 Port 9 Line-In Audio Connector (blue)

4 VGA Monitor Connector 10 Line-Out Connector for powered audio 
devices (green)

5 HDMI Port 11 Microphone Connector

6 USB 3.0 Port   

NOTE: When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if 
you want to use the connector for a line-in device or a microphone. You can reconfigure the connector at 
any time by double-clicking the Audio Manager icon in the Windows taskbar.

When a graphics card is installed in one of the system board slots, the video connectors on the graphics 
card and the integrated graphics on the system board may be used at the same time. However, for such a 
configuration, only the display connected to the discrete graphics card will display POST messages.

The system board graphics can be disabled by changing settings in Computer Setup.

Rear panel components 3



2 Illustrated parts catalog

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then 
follow the on-screen instructions.

Computer major components

Item Description

(1) Access panel

(2) Front bezel

(3) System board (includes replacement thermal material)
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Item Description

(4) Power supply, 180W

(5) Fan sink (includes replacement thermal material)

(6) Intel Core i3-4170 processor (include replacement thermal material)

(7) Memory module, 4 GB (PC3-12800)

(8) Front I/O assembly

(9) Power switch

(10) Optical drive latch

* SATA data cable, 165 mm

* SATA data cable, 254 mm

* Mouse, USB

* Keyboard, USB

* Power cord

Drives

Item Description

(1) Hard drive, 500 GB, 7200 rpm

(2) DVD drive

Drives 5



3 Routine care, SATA drive guidelines, and 
disassembly preparation

This chapter provides general service information for the computer. Adherence to the procedures and 
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the system 
board. You must disconnect the power cord from the power source before opening the computer to prevent 
system board or component damage. 

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive 
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device 
exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work perfectly 
throughout a normal cycle. The device may function normally for a while, but it has been degraded in the 
internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt silicon junctions.

Generating static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

Removing DIPs from vinyl tray

Removing DIPs from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.
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Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of 
sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric 
components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive 
foam.

Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground cords. 
To provide proper ground, a strap must be worn snug against bare skin. The ground cord must be 
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible with 
most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with 
a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the work area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to the 
work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate. Handle 
them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Electrostatic discharge information 7



Recommended materials and equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Operating guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented sides 
of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the 
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also 
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign matter 
can block the vents and limit the airflow. Be sure to unplug the computer before cleaning the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they are subject 
to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must be 
provided on the enclosure, and the same operating guidelines listed above will still apply.

● Keep liquids away from the computer and keyboard.
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● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software, including 
sleep states.

Routine care

General cleaning safety precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use 
the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General cleaning safety precautions on page 9 before cleaning the computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with a cloth 
or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will evaporate 
quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents and 
limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 9 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the Computer 
Case on page 9.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions on page 9 
before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the 
keys. 

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be used as too 
much air pressure can dislodge lubricants applied under the wide keys.
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● If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool is 
available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed out. Be 
careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any 
fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor

● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for 
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into the 
housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 9.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out any 
debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 9.

Service considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and 
assembly of the computer.

Power supply fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is off when 
the computer is in “Standby,” “Suspend,” or “Off” modes. 

You must disconnect the power cord from the power source before opening the computer to prevent system 
board or component damage.

Tools and software Requirements

To service the computer, you need the following:

● Torx T-15 screwdriver

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● Tamper-resistant T-15 wrench
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Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads and may 
be of different lengths. If an incorrect screw is used during the reassembly process, it can damage the unit. HP 
strongly recommends that all screws removed during disassembly be kept with the part that was removed, 
then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the work area 
to prevent damage.

Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care to 
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal from 
the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or twisting the 
cables, and ensure that the cables are routed in such a way that they cannot be caught or snagged by parts 
being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location during the 
reassembly process. Improper cable placement can damage the computer. 

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies 
to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging 
and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective 
packaging until they are actually mounted in the computer.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive while the 
computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid 
touching the connector.

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 
such as monitors or speakers.

Lithium coin cell battery

The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime 
of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide for 
instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery is 
handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire, or 
expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the battery.
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NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public collection 
system or return them to HP, their authorized partners, or their agents.

SATA hard drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 6.0 Gb/s

SATA hard drive cables

SATA data cable

Always use an HP approved SATA 6.0 Gb/s cable as it is fully backwards compatible with the SATA 1.5 Gb/s 
drives.

Current HP desktop products ship with SATA 6.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never bend it 
tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SMART ATA drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal Computers 
have built-in drive failure prediction that warns the user or network administrator of an impending failure or 
crash of the hard drive. The SMART drive tracks fault prediction and failure indication parameters such as 
reallocated sector count, spin retry count, and calibration retry count. If the drive determines that a failure is 
imminent, it generates a fault alert.
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Cable management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these are not 
designed to take excessive pressure on them.

● Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when the parts 
are moved.

● When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the wires.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Do not bend any cable sharply. A sharp bend can break the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables down 
into the chassis. Always position the cables to lay properly by themselves.

Cable management 13



4 Removal and replacement procedures – 
small form factor (SFF) chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service. After 
completing all necessary removal and replacement procedures, run the Diagnostics utility to verify that all 
components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly
See Routine care, SATA drive guidelines, and disassembly preparation on page 6 for initial safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Close any open software applications.

3. Exit the operating system.

4. Remove any compact disc or media card from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the system 
is plugged into an active AC outlet. In some systems the cooling fan is on even when the computer is in 
the “Standby,” or “Suspend” modes. The power cord should always be disconnected before servicing a 
unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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Access panel
1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Loosen the Torx screw that secures the access panel (1), and then slide the panel back and lift it off the 
computer (2).

To install the access panel, reverse the removal procedure.

Access panel 15



Optical drive
NOTE: You do not have to remove the front bezel to remove the optical drive.

The optical drive must be connected to the white primary SATA connector on the system board labeled SATA1.

CAUTION: All removable media should be taken out of a drive before removing the drive from the computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Disconnect the power cable and data cable (1) from the rear of the optical drive, push the green release 
latch on the rear side of the drive toward the center of the drive (2), and then slide the drive forward and 
out of the bay through the front bezel (3).

CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to avoid 
damaging the cable.
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Memory
The computer comes with double data rate 4 synchronous dynamic random access memory (DDR4-SDRAM) 
dual inline memory modules (DIMMs).

DIMMs

The memory sockets on the system board can be populated with up to two industry-standard DIMMs. These 
memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum memory 
support, you can populate the system board with up to 16-GB of memory configured in a high-performing 
dual channel mode.

DDR3-SDRAM DIMMs

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

● 1.35 volt or 1.5 volt DDR3/DDR3L-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM sockets

There are two DIMM sockets on the system board, with one socket per channel. The sockets are labeled 
DIMM1 and DIMM3. Socket DIMM1 operates in memory channel B. Socket DIMM3 operates in memory channel 
A.

The system will automatically operate in single channel mode, dual channel mode, or flex mode, depending 
on how the DIMMs are installed.

NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior graphics 
performance.

● The system will operate in single channel mode if the DIMM sockets are populated in one channel only.

● The system will operate in a higher-performing dual channel mode if the memory capacity of the DIMM 
in Channel A is equal to the memory capacity of the DIMM in Channel B.

● The system will operate in flex mode if the memory capacity of the DIMM in Channel A is not equal to the 
memory capacity of the DIMM in Channel B. In flex mode, the channel populated with the least amount 
of memory describes the total amount of memory assigned to dual channel and the remainder is 
assigned to single channel. If one channel will have more memory than the other, the larger amount 
should be assigned to Channel A.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power to drain 
before adding or removing memory modules. Regardless of the power-on state, voltage is always supplied to 
the memory modules as long as the computer is plugged into an active AC outlet. Adding or removing 
memory modules while voltage is present may cause irreparable damage to the memory modules or system 
board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is important 
to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation resulting from 
having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before beginning 
these procedures, ensure that you are discharged of static electricity by briefly touching a grounded metal 
object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage the 
module.

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Rotate up the internal drive bay housing to access the memory module sockets on the system board.

4. Open both latches of the memory module socket (1), and insert the memory module into the socket (2).

NOTE: A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket.
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5. Push the module down into the socket, ensuring that the module is fully inserted and properly seated. 
Make sure the latches are in the closed position (3).

6. Repeat steps 4 and 5 to install any additional modules.

7. Replace the access panel.

8. If the computer was on a stand, replace the stand.

9. Reconnect the power cord and turn on the computer.

10. Lock any security devices that were disengaged when the access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the computer.
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Expansion card
The computer offers one PCI Express x16 expansion socket.

NOTE: The PCI Express socket supports only low profile cards.

You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16 socket.

To remove an expansion card:

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Locate the correct vacant expansion socket on the system board and the corresponding expansion slot 
on the back of the computer chassis.

4. Remove the Torx screw that secures the expansion slot cover retention latch (1), and then rotate the 
bottom of the latch upward and remove it (2).

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be attached to 
the expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate expansion slot 
cover on the back of the chassis. Pull the slot cover straight up then away from the inside of the 
chassis.
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b. If you are removing a PCI Express x1 card, hold the card at each end, and carefully rock it back and 
forth until the connectors pull free from the socket. Pull the expansion card straight up from the 
socket (1) then away from the inside of the chassis to release it from the chassis frame (2). Be sure 
not to scrape the card against the other components.

NOTE: If you are removing a PCI Express x16 card, rotate the latch on the end of the connector 
away from the card to disengage before removing the card.

NOTE: If you are installing a PCI Express x16 card, pull the retention arm on the back of the 
expansion socket toward the card to lock the card into place.

NOTE: If you are installing a PCI Express x1 card, insert the card straight down into the socket.

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open slot.

CAUTION: After removing an expansion card, you must replace it with a new card or expansion slot 
cover for proper cooling of internal components during operation.

8. Rotate the slot cover retention latch back in place to secure the expansion card.

9. Connect external cables to the installed card, if needed. Connect internal cables to the system board, if 
needed.
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WLAN module
The wireless module is secured to the system board and has one antenna cable connected.

To remove the WLAN module:

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Disconnect the WLAN antenna cable from the terminal labeled “1” on the WLAN module.

4. Remove the Phillips screw that secures the WLAN module to the system board. (The edge of the module 
opposite the slot rises away from the computer.)

5. Remove the WLAN module by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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RTC battery
The battery installed on the computer provides power to the real-time clock. When replacing the battery, use 
a battery equivalent to the battery originally installed on the computer. The computer has a 3-volt lithium 
coin cell battery installed.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60°C (140ºF).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When the 
battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries. For more information about recycling programs, go to http://www.hp.com/recycle.

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Locate the battery and battery holder on the system board.

4. Pull back on the clip (1) that is holding the battery in place, and remove the battery (2).

5. Insert the new battery and position the clip back into place.

To install the RTC battery, reverse the removal procedure.
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Power supply
WARNING! To reduce potential safety issues, only the power supply provided with the computer, a 
replacement power supply provided by HP, or a power supply purchased as an accessory from HP should be 
used with the computer.

WARNING! Voltage is always present on the system board when the computer is plugged into an active AC 
outlet. To avoid possible personal injury and damage to the equipment the power cord should be 
disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. From the outside, rear of the chassis, remove the four Torx screw that secure the power supply to the 
chassis.
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4. From the inside of the chassis, disconnect the power cables from the following components:

(1): ATX_CPU connector

(2): ATX_POWER connector

(3): Optical drive

(4): Hard drive

5. Push the release lever at the front of the power supply (1), slide the power supply forward, and then 
remove it from the chassis (2).

To install the power supply, reverse the removal procedure.
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Fan sink
CAUTION: The bond between the fan sink and the processor may be very tight. 

If the computer will power on, before removing the fan sink, turn on the computer until it warms the fan sink. 
Warming the heat sink lessens the bond between the fan sink and the processor, thereby making separating 
them easier.

Make sure not to pull the processor out of the socket when you lift the fan sink, especially if you cannot warm 
the fan sink prior to removal. Inadvertently removing the processor can damage the pins.

The fan sink is secured atop the processor with four captive Torx screws.

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Disconnect the fan cable from the system board connector labeled CPUFAN, and then loosen the four 
captive screws that secure the fan sink to the system board tray.

CAUTION: Fan sink retaining screws should be removed in diagonally opposite pairs (as in an X) to even 
the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.
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4. Lift the fan sink from atop the processor and set it on its side to keep from contaminating the work area 
with thermal grease.

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and fresh 
thermal grease has been applied to the top of the processor.

CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to evenly 
seat the fan sink on the processor to avoid damage that could require replacing the system board.
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Processor
1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Remove the fan sink (Fan sink on page 26).

4. Rotate the locking lever to its full open position (1).

5. Raise and rotate the microprocessor retainer to its fully open position (2).

6. Lift the processor (3) straight up and remove it.

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to the 
processor’s solder connections.

NOTE: After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be found on the 
Web at: http://www8.hp.com/us/en/support-drivers.html.
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System board
NOTE: All system board spare part kits include replacement thermal material.

NOTE: System board appearance may vary.

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. When replacing the system board, make sure the following components are removed from the defective 
system board and installed on the replacement system board:

● Memory modules (Memory on page 17)

● Expansion card (Expansion card on page 20)

● Fan sink (Fan sink on page 26)

● Processor (Processor on page 28)

4. Disconnect the following cables from the system board, noting their location for reinstallation:

(1): Power supply

(2): Hard drive data

(3): Optical drive data

(4): Front I/O assembly

(5): Power supply

(6): Front I/O assembly

(7): Front I/O assembly

(8): Power switch

5. Remove the four Torx T15 screws that secure the system board to the chassis.
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6. Slide the system board toward the front of the computer to disengage the I/O panel, and then lift the 
system board out of the computer.

When reinstalling the system board, first insert the I/O panel back into the slots in the rear of the chassis, and 
then align the board with the chassis screw holes.

NOTE: When replacing the system board, you must change the chassis serial number in the BIOS.
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System board callouts

Sys Bd Label Color Component  Sys Bd Label Color Component

CPUFAN White Processor fan  PSWD+PW Blue Clear system passwords 
and CMOS

XMM1 White Memory module  SATA1 Light blue Optical drive

XMM2 Black Memory module  SATA0 Dark blue Hard drive

PROCESSOR Black Processor  PCIE_X16 Black Expansion card

ATX_POWER White 24-pin main power  F_AUDIO Yellow Front I/O assembly

F_USB1 White Front I/O assembly  BATTERY Black RTC battery

F_USB2 White Front I/O assembly  NGF_WLAN Black WLAN module

F_PANEL Black Power switch  ATX_CPU White 4-pin power connector
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Front bezel
1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Lift up the three tabs on the top of the bezel (1), and then rotate the top of the bezel downward and 
remove it from the computer (2).

To install the front bezel, reverse the removal procedure.

Hard drive
The hard drive must be connected to the dark blue primary SATA connector on the system board labeled 
SATA0.

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you 
can transfer the data to the new hard drive.

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the computer, and 
unplug the power cord. Do not remove a drive while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid 
touching the connector. For more information about preventing electrostatic damage, refer to Electrostatic 
discharge information on page 6.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields such as 
monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label the 
package “Fragile: Handle With Care.”

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Remove the front bezel (Front bezel on page 32).
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4. Disconnect the power cable and data cable from the back of the hard drive.

5. Remove the four Phillips screws (three on front of computer, one inside of computer) that secure the 
drive cage (1), slide the cage back, and then remove it from the computer (2).
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6. Remove the four Phillips screws that secure the drive to the cage (1), and then pull the drive out of the 
cage (2).

When installing a hard drive, use the following image to determine screw locations for the hard drive.

Avoid routing cables under the hard drive cage in the locations shown in the following image.
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When installing the drive cage, make sure the slots at the bottom of the cage fit into the tabs built into the 
bottom of the chassis.
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Front I/O assembly
The front I/O assembly is attached to the front of the chassis with one screw. Pull the assembly away from the 
chassis to remove.

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Remove the front bezel (Front bezel on page 32).

4. Disconnect the cables from the system board as follows:

(1) White connector labeled F_USB1

(2) White connector labeled F_USB2

(3) Yellow connector labeled F_AUDIO

5. Remove the cables from the clip built into the basepan (4).

Note the orientation of how the cable fits onto the right four pins of F_USB2 connector.

6. Remove the Torx screw (1) that secures the assembly to the front of the chassis.
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7. Slide the assembly toward the left (2).

8. Rotate the assembly downward and pull away from the computer while pulling the cables through the 
opening in the front of the computer.

To install the front I/O assembly, reverse the removal procedure.
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Power switch
The power switch is attached to the left, front of the chassis. The power switch is removed by pulling it away 
from the front of the chassis.

1. Prepare the computer for disassembly (Preparation for disassembly on page 14).

2. Remove the access panel (Access panel on page 15).

3. Remove the front bezel (Front bezel on page 32).

4. Disconnect the cable from the system board connector labeled F_PANEL(1), and remove the cable from 
the clips built into the basepan (2).

5. From the inside of the chassis, press down on the tab at the top of the power switch assembly (1), and 
the pull the assembly away from the front of the chassis while routing the cable through the hole in the 
chassis (2).

To install the power switch, reverse the removal procedures.
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5 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics, 
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media devices.

● Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run during a 
Full Boot. You can set the system to:

■ always Quick Boot (default);

■ periodically Full Boot (from every 1 to 30 days); or

■ always Full Boot.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test (POST) 
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product 
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the 
mode selected. To manually switch to Post Messages Enabled during POST, press any key (except F1 
through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or 
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings 
described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or embedded NIC, 
so that they cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-Test 
(POST).

● Replicate the system setup by saving system configuration information on a USB device and restoring it 
on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).
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Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access the 
Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup, 
including the Computer Setup utility.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again 
repeatedly press F10 when the monitor light turns green to access the utility.

3. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security, Power, 
and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys 
to select the option you want, then press Enter. To return to the Computer Setup Utilities menu, press 
Esc.

5. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select Apply 
Defaults and Exit. This option will restore the original factory system defaults.

NOTE: Not all settings shown in the following sections are available for all models

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes 
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10 Setup 
screen.
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-1  Computer Setup—File

Option Description

System Information Lists:

● Manufacturer

● Product name

● SKU number

● Serial number

● Born on date

● System Board ID and CT Number

● System BIOS Version and Date

● Processor type/speed

● Installed memory size/speed, number of channels (single or dual) (if applicable)

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.

Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and Exit Applies the currently selected default settings and clears any established passwords.

Ignore Changes and Exit Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-2  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options may be 
presented:

● Hard Disk: Size, model, firmware version, serial number, connector color, SMART category.

● CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-ROM).

● Diskette: Model and firmware version.

NOTE: Displays for USB diskette drives.

Storage Options SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system. There 
are two supported options: IDE and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and degrade or 
corrupt established volumes.

IDE - This is the most backwards-compatible setting of the options. Operating systems usually do not 
require additional driver support in IDE mode.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage of 
more advanced features of the SATA controller.

NOTE: The AHCI device driver must be installed prior to attempting to boot from a AHCI volume. If you 
attempt to boot from a AHCI volume without the required device driver installed, the system will crash 
(blue screen).

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.

DPS Self-test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection System 
(DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS self tests is 
attached to the system.

Boot Order Allows you to:

● UEFI Boot Sources: Specify the order in which EFI boot sources (such as a internal hard drive, USB 
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating system 
image. Each device on the list may be individually excluded from or included for consideration as a 
bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

● Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network interface 
card, internal hard drive, USB optical drive, or internal optical drive) are checked for a bootable 
operating system image. Each device on the list may be individually excluded from or included for 
consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in the 
boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from consideration as a 
bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.
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Table 5-2  Computer Setup—Storage (continued)

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has 
started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the computer 
and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot menu) 
when the monitor light turns green. After POST is completed, a list of bootable devices is displayed. Use 
the arrow keys to select the preferred bootable device and press Enter. The computer then boots from the 
selected non-default device for this one time.

Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-3  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the ROM, and 
make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears after a 
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Password Options

(This selection appears 
only if a power-on 
password or setup 
password is set.)

Allows you to enable/disable:

● Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to change 
resource settings for serial and parallel ports).

● Stringent security (enabling the stringent password disables the ability to reset the password by 
moving the jumper on the system board). Default is disabled.

CAUTION: If you enable the stringent security feature and you forget the setup password or the 
power-on password, the computer is inaccessible and can no longer be used.

If you lose or forget the password, the system board must be replaced. This scenario is not covered 
under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup 
password or power-on password in a safe place away from your computer. Without these 
passwords, the computer cannot be unlocked.

● Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing, the F10 
Setup Options without entering setup password). Default is enabled.

● Password prompt on F9 & F12 (requires setup password to use these boot functions). Default is 
enabled.

● Network Server Mode. Default is disabled.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● System audio

● Network controller

NOTE: You must disable AMT before trying to hide the network controller.

● SATA0

● SATA1

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:
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Table 5-3  Computer Setup—Security (continued)

● Front USB Ports

● Rear USB Ports

Slot Security Allows you to disable any PCI or M.2 card slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network server. 
(Feature available on NIC models only; the network controller must be either a PCI expansion card or 
embedded on the system board.) Default is enabled.

System IDs Allows you to set:

● Product name

● Serial number

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current chassis serial 
number is invalid. (These ID numbers are normally set in the factory and are used to uniquely 
identify the system.)

● SKU Number

● Family Name

● Feature Byte

● Build ID

● Keyboard locale setting for System ID entry.

System Security (these 
options are hardware 
dependent)

NOTE: Available options are displayed depending on system configuration.

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches. Default is 
enabled.

Virtualization Technology (VTx/VTd) (enable/disable) - Controls the virtualization features of the 
processor. Changing this setting requires turning the computer off and then back on. Default is disabled.

Secure Boot 
Configuration

CAUTION: Changing the default Secure Boot settings on operating systems that do not support Secure 
Boot may prevent the system from booting successfully.

● Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer, 
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so on. If set 
to disable, legacy boot options in Storage > Boot Order are not displayed. Default is enabled.

● Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate before 
booting to it, making Windows resistant to malicious modification from preboot to full OS booting, 
preventing firmware attacks. UEFI and Windows Secure Boot only allow code signed by pre-
approved digital certificates to run during the firmware and OS boot process. Default is disabled, 
except for Windows 10 systems which have this setting enabled. Secure Boot enabled also sets 
Legacy Support to disabled.

● Key Management—This option lets you manage the custom key settings.

◦ Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded custom 
boot keys. Default is Don't Clear.

◦ Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify the 
contents of the secure boot signature databases and the platform key (PK) that verifies kernels 
during system start up, allowing you to use alternative operating systems. Selecting HP Keys 
causes the computer boot using the preloaded HP-specific boot keys. Default is HP Keys.

● Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f keys 
to access items before the operating system loads. Default is disabled.

NOTE: If Windows detects a serious error, it will interrupt the boot process automatically and 
display advanced boot options.

From Windows, you can press Shift and select Restart to access the screen that lets you boot to a 
device or troubleshoot your computer.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-4  Computer Setup—Power

Option Description

OS Power Management ● Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the 
processors power consumption when the processor is idle. Default is extended.

● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce 
processor voltage and frequency when the current software load does not require the full 
capabilities of the processor. Default is enabled.

Hardware Power 
Management

SATA Power Management – Enables or disables SATA bus and/or device power management. Default is 
enabled.

S4/S5 Wake on LAN – Enables or disables remotely waking up the computer from S4 (hibernation) or S5 
(power is off) power state. Default is disabled.

Thermal System fan speed—Shows system fan speed.

Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-5  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST messages (enable/disable). Enabling this feature will cause the system to display POST error 
messages, which are error messages displayed on the monitor during the Power On Self Test if the 
BIOS encounters some kind of problem while starting the PC. A POST error message will only display 
on screen if the computer is capable of booting this far. If the POST detects an error before this 
point, a beep code is generated instead. Default is disabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is restored, 
if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able to 
use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST process. 
This delay is sometimes needed for hard disks on some PCI cards that spin up very slowly, so slowly 
that they are not ready to boot by the time POST is finished. The POST delay also gives you more 
time to select F10 to enter Computer (F10) Setup. Default is None.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Bus Options Allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.
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Table 5-5  Computer Setup—Advanced (for advanced users) (continued)

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration space; only 
needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

● Num Lock State at Power-On (off/on). Default is off.

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under the OS. 
Default is enabled.

● NIC PXE Option ROM Download. The BIOS contains an embedded NIC option ROM to allow the unit to 
boot through the network to a PXE server. This is typically used to download a corporate image to a 
hard drive. The NIC option ROM takes up memory space below 1MB commonly referred to as DOS 
Compatibility Hole (DCH) space. This space is limited. This F10 option will allow users to disable the 
downloading of this embedded NIC option ROM thus giving more DCH space for additional PCI cards 
which may need option ROM space. The default will be to have the NIC option-ROM-enabled.

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command with the 
Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File on page 41 in the 
Computer Setup—File table.)

NOTE: It is recommended that you save any modified computer configuration settings to a USB flash media 
device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and perform the 
Restore from Removable Media command with the Computer Setup (F10) Utility. (See Computer Setup—File 
on page 41 in the Computer Setup—File table.)
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6 Troubleshooting without diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices, hard 
drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems with the 
computer, refer to the tables in this chapter for probable causes and recommended solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On Self-Test 
(POST) at startup, refer to POST error messages and diagnostic front panel LEDs and audible codes 
on page 76.

Safety and comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment may 
result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/ergo for 
more information on choosing a workspace and creating a safe and comfortable work environment. For more 
information, refer to the Safety & Regulatory Information guide.

Before you call for technical support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the exact 
problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 39 for 
more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error 
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel 
LEDs and audible codes on page 76 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is available. Or, 
replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network 
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions properly.

● If you recently installed new software, uninstall the software and see if the computer functions properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When booting 
the operating system, use “Last Known Configuration.”

● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful hints on page 48 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with self-
solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's online chat 
feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online support 
information, software and drivers, proactive notification, and worldwide community of peers and HP experts.
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If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your 
service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its original 
factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files before 
running the restore process.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service provider 
or dealer.

Helpful hints
If you encounter problems with the computer, monitor, or software, see the following list of general 
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your region 
(115V or 230V).

● Check that the computer is turned on and the white power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error 
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel 
LEDs and audible codes on page 76 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.

● Wake the computer by pressing any key on the keyboard or pressing the power button. If the system 
remains in suspend mode, shut down the computer by pressing and holding the power button for at 
least four seconds then press the power button again to restart the computer. If the system will not shut 
down, unplug the power cord, wait a few seconds, then plug it in again. The computer will restart if it is 
set to power on automatically as soon as power is restored in Computer Setup. If it does not restart, 
press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option. See 
Solving hardware installation problems on page 64 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a printer, 
you need a driver for that model printer.

● Remove all bootable media (CD/DVD or USB device) from the system before turning it on.
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● If you have installed an operating system other than the factory-installed operating system, check to be 
sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed (embedded 
video on some models only) and a single monitor, the monitor must be plugged into the monitor 
connector on the source selected as the primary VGA adapter. During boot, the other monitor connectors 
are disabled and if the monitor is connected into these ports, the monitor will not function. You can 
select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied to the 
system board. You must disconnect the power cord from the power source before opening the computer to 
prevent system board or component damage.

Solving general problems
You may be able to easily resolve the general problems described in this section. If a problem persists and you 
are unable to resolve it yourself or if you feel uncomfortable about performing the operation, contact an 
authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system 
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect 
the power cord from the wall outlet and allow the internal system components to cool before touching.

Cannot access the Computer Setup (F10) Utility when booting the computer.

Cause Solution

The Computer Setup (F10) Utility is set to “fast boot” causing the 
F10 access screen to display too briefly when booting the 
computer.

Before turning on the computer, press and hold F10. Turn on the 
computer and continue to hold F10 until the Computer Setup 
(F10) Utility is displayed.

- or –

Follow the Windows instructions for rebooting the computer into 
the Computer Setup (F10) Utility.

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds 
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

System has locked up. Restart computer.
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Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet prolongs the 
life of the RTC battery.

Reset the date and time under Control Panel (Computer Setup 
can also be used to update the RTC date and time). If the problem 
persists, replace the RTC battery. See the Removal and 
Replacement section for instructions on installing a new battery, 
or contact an authorized dealer or reseller for RTC battery 
replacement.

To access Control Panel in Windows 10, type control panel in 
the taskbar search box, and then select Control Panel.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is turned on. Press the Num Lock key. The Num Lock light must be off if you 
want to use the arrow keys on the keypad. You can also disable or 
enable the Num Lock key in Computer Setup at Advanced > 
Device Options.

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the Computer Setup settings to make sure the 
internal system speaker is not muted (this setting does not 
affect the external speakers).

2. Make sure the external speakers are properly connected and 
powered on and that the speakers' volume control is set 
correctly.

3. Use the system volume control available in the operating 
system to make sure the speakers are not muted or to 
increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer 
malfunction, you must manually disable the Smart Cover lock . A 
key to unlock the Smart Cover Lock is not available from HP. Keys 
are typically available from a hardware store.

Poor performance.

Cause Solution

Processor is too hot. 1. Make sure airflow to the computer is not blocked. Leave a 
10.2-cm (4-inch) clearance on all vented sides of the 
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Poor performance.

Cause Solution

computer and above the monitor to permit the required 
airflow.

2. Make sure fans are connected and working properly (some 
fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on the 
hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved memory 
back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory.

3. Some applications run in the background and can be closed 
by right-clicking on their corresponding icons in the task 
tray. To prevent these applications from launching at 
startup:

In Windows 10:

a. Type msconfig in the taskbar search box, and then 
select msconfig.

b. On the Startup tab of the System Configuration Utility, 
click Open Task Manager..

c. Select applications that you do not want to launch 
automatically, and the click Disable.

Some software applications, especially games, are stressful on 
the graphics subsystem.

1. Lower the display resolution for the current application or 
consult the documentation that came with the application 
for suggestions on how to improve performance by 
adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and the 
processor cooling fan is running.

2. Open the access panel, press the power button, and see if 
the processor fan (or other system fan) spins. If the fan does 
not spin, make sure the fan cable is plugged onto the system 
board header.
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Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

3. If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the 
hard drive LED turns white, then:

1. If equipped with a voltage selector, check that the voltage 
selector (located on the rear of the power supply) is set to 
the appropriate voltage. Proper voltage setting depends on 
your region.

2. Remove the expansion cards one at a time until the 5V_aux 
light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If the 
hard drive LED does not turn on white then:

1. Check that the unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button 
cable is properly connected to the system board.

3. Check that the power supply cables are properly connected 
to the system board.

4. Check to see if the 5V_aux light on the system board is 
turned on. If it is turned on, then replace the power button 
assembly.

5. If the 5V_aux light on the system board is off, then replace 
the power supply.

6. Replace the system board.

Solving power problems
Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch on 
rear of computer chassis (some models) not switched to correct 
line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power supply 
fault.

Replace the power supply.
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Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and the 
processor cooling fan is running.

2. Open the access panel, press the power button, and see if 
the processor fan (or other system fan) spins. If the fan does 
not spin, make sure the fan cable is plugged onto the system 
board header.

3. If fan a plugged in and not spinning, replace it.

Computer powered off automatically and the Power LED flashes red three times and then white four times.

Cause Solution

Power failure (power supply is overloaded). 1. If equipped with a voltage selector, check that the voltage 
selector, located on the rear of the power supply (some 
models), is set to the appropriate voltage. Proper voltage 
setting depends on your region.

2. Open the access panel and ensure the power supply cable is 
seated into the connector on the system board.

3. Check if a device is causing the problem by removing ALL 
attached devices (such as hard drives or optical drives and 
expansion cards). Power on the system. If the system enters 
POST, then power off and replace one device at a time and 
repeat this procedure until failure occurs. Replace the device 
that is causing the failure. Continue adding devices one at a 
time to ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.

Solving hard drive problems
Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Windows 10, type file in the taskbar search box, and 
then select File Explorer from the list of applications. In the 
left column, expand This PC, right-click on a drive, select 
Properties, and then select the Tools tab. Under Error 
checking click Check.

2. Use a utility to locate and block usage of bad sectors. If 
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with a 
file.

In Windows 10, type file in the taskbar search box, and then 
select File Explorer from the list of applications. In the left 
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Disk transaction problem.

Cause Solution

column, expand This PC, right-click on a drive, select Properties, 
and then select the Tools tab. Under Error checking click Check.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly 
installed device.

See reconfiguration directions in the Solving hardware installation 
problems on page 64 section. If the system still does not 
recognize the new device, check to see if the device is listed within 
Computer Setup. If it is listed, the probable cause is a driver 
problem. If it is not listed, the probable cause is a hardware 
problem.

If this is a newly installed drive, run the Computer Setup utility 
and try adding a POST delay under Advanced > Power-On 
Options.

The device is attached to a SATA port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in Advanced > 
Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from the hard drive but the hard 
drive may have been damaged.

▲ Perform Drive Protection System (DPS) testing in system 
ROM.

System files missing or not properly installed. 1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the 
recovery option. If only a restore kit is available, then select 
the File Backup Program option, and then restore the 
system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive entry in 
the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard drive 
configuration.

If attempting to boot from a hard drive, ensure it is attached to 
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order. Run the Computer Setup utility and select Storage > Boot Order 
and ensure the bootable hard drive is listed immediately under 
the Hard Drive entry.
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Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden in 
Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device Available 
is selected for the device's SATA port in Security > Device 
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in 
Storage  > Boot Order.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if any 
beeps are heard. See POST error messages and diagnostic front 
panel LEDs and audible codes on page 76 to determine possible 
causes for the blinking red and beep codes.

See the Worldwide Limited Warranty for terms and conditions.

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. 1. Use the task manager to close programs that do not 
respond.

2. Attempt the normal Windows “Shut Down” procedure. If this 
fails, press the power button for four or more seconds to 
turn off the power. To restart the computer, press the power 
button again.

Solving media card reader problems
Media card will not work in a digital camera after formatting it in Windows.

Cause Solution

By default, Windows will format any media card with a capacity 
greater than 32MB with the FAT32 format. Some digital cameras 
use the FAT (FAT16 & FAT12) format and can not operate with a 
FAT32 formatted card.

Either format the media card in the digital camera or select FAT 
file system to format the media card in a computer with Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety feature 
that prevents writing to and deleting from an SD/Memory 
Stick/PRO card.

If using an SD card, make sure that the lock tab located on the 
right of the SD card is not in the locked position. If using a Memory 
Stick/PRO card, make sure that the lock tab located on the bottom 
of the Memory Stick/PRO card is not in the locked position.
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Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your card 
to see if it writable. Refer to the previous section for a list of 
compatible cards.

Media card is locked. Locking the media card is a safety feature 
that prevents writing to and deleting from an SD/Memory 
Stick/PRO card.

If using an SD card, make sure that the lock tab located on the 
right of the SD card is not in the locked position. If using a Memory 
Stick/PRO card, make sure that the lock tab located on the bottom 
of the Memory Stick/PRO card is not in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the wrong 
slot, or is not supported.

Ensure that the card is inserted properly with the gold contact on 
the correct side. The green LED will light if inserted properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 10, type file in the taskbar search box, and then 
select File Explorer from the list of applications. In the left 
column, expand This PC, right-click on the corresponding drive 
icon, and then select Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized by the 
computer.

Cause Solution

The operating system needs time to recognize the device if the 
reader was just installed into the computer and you are turning 
the PC on for the first time.

Wait a few seconds so that the operating system can recognize 
the reader and the available ports, and then recognize the media 
inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove it 
during boot or do not select the option to boot from the 
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the 
boot menu.

3. Change the boot sequence in F10 Computer Setup.
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Solving display problems
If you encounter display problems, see the documentation that came with the monitor and to the common 
causes and solutions listed in the following table.

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer and 
to the electrical outlet.

You may have a screen blanking utility installed or energy saver 
features are enabled.

Press any key or click the mouse button and type your password 
(if set).

System ROM is corrupted; system is running in Boot Block 
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the 
resolution chosen.

Be sure that the monitor can accept the same horizontal scan rate 
as the resolution chosen.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Monitor cable is plugged into the wrong connector. Systems may have a monitor connection on both the 
motherboard or an add-in card. Try moving the monitor 
connection to a different connector on the back of the computer

Monitor settings in the computer are not compatible with the 
monitor.

1. In Control Panel, select Category from the View by list, then 
under Appearance and Personalization, select Adjust 
screen resolution.

To access Control Panel in Windows 10, type control 
panel in the taskbar search box, and then select Control 
Panel from the list of applications.

2. Expand the Resolution box, and then use the sliding control 
to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the input 
that is being driven by the system. Refer to the monitor's user 
documentation for more information on the on-screen controls 
and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the computer 
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the computer 
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the 
system.

2. Replace the graphics card (if applicable).

3. Replace the system board.

For systems with integrated graphics, replace the system board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and the computer 
beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with 
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the 
graphics card (if applicable) or video connector and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics 
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.
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The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor may 
be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the 
computer.

2. In a two-monitor system or if another monitor is in close 
proximity, be sure the monitors are not interfering with each 
other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came with 
the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu. Select 
ImageControl/ Horizontal Position or Vertical Position to adjust 
the horizontal or vertical position of the image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while 
connecting the video cable.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what the 
monitor supports.

Restart the computer and enter Safe Mode. Change the settings to 
a supported setting then restart the computer so that the new 
settings take effect.

To enter Safe Mode in Windows 10:

1. Log into the computer using an Administrator account.

2. Type msconfig in the taskbar search box, and then select 
msconfig from the list of applications.

3. Click the Boot tab, select Safe boot and then click OK.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the 
picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may be 
unable to correctly interpret the output synchronization of the 
graphics card.

1. Select the monitor’s Auto-Adjustment option in the 
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-screen 
display functions. To download a SoftPaq that will assist you 
with the synchronization, go to the following Web site, 
select the appropriate monitor, and download either 
SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad (some models). 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular symbol. Use the Character Map to locate and select the appropriate 
symbol. You can copy the symbol from the Character Map into a 
document.

In Windows 10, type ch in the taskbar search box, and then select 
Character Map from the list of applications.

Solving audio problems
If the computer has audio features and you encounter audio problems, see the common causes and solutions 
listed in the following table.

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open applications. Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make sure 
that Mute is not selected and use the volume slider to adjust the 
volume.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security > Device Security > 
System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the 
computer. The rear audio jack output is the green receptacle. The 
speakers should be plugged into the line-out jack and the 
headphones should be plugged into the headphone jack.

60 Chapter 6   Troubleshooting without diagnostics

http://www.hp.com/support


Sound does not come out of the speaker or headphones.

Cause Solution

External speakers plugged into the wrong audio jack on a recently 
installed sound card.

See the sound card documentation for proper speaker connection. 
The rear audio jack output is the green receptacle.

Headphones or devices connected to the line-out connector mute 
the internal speaker.

Turn on and use headphones or external speakers, if connected, 
or disconnect headphones or external speakers.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select Advanced > 
Device Options > Internal Speaker.

The application is set to use a different audio device than 
speakers.

Some graphics cards support audio over the DisplayPort 
connection (if applicable), so multiple audio devices may be listed 
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio 
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output connector. 
The rear audio output connector is for powered audio devices and 
is not designed for headphone use.

Plug the headphones into the headphone connector on the front 
of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on the 
hard disk. You can also try recording the audio file in a 
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application 
software.

In the audio driver or application software, reconfigure the jack or 
set the jack to its default value.
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There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than 
speakers.

Some graphics cards support audio over the DisplayPort 
connection (if applicable), so multiple audio devices may be listed 
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio 
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Solving printer problems
If you encounter printer problems, see the documentation that came with the printer and to the common 
causes and solutions listed in the following table.

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed. 1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being 
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type cmd 
in the Open box, and then click OK.

If you are on a network, you may not have made the connection 
to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and electrical 
outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.
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Printer prints garbled information.

Cause Solution

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it back 
on.

Printer will not print.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty.

Solving keyboard and mouse problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment and to 
the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/keyboard, or no 
function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected USB 
3.0 devices can interfere with the wireless keyboard USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0 port that 
is separated from ports with USB 3.0 devices. If you still 
experience interference, you may have to place the connectors 
farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. Shut down the computer, reconnect the keyboard to the back of 
the computer, and then restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart the 
computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is on. Press the Num Lock key. The Num Lock light should be off if you 
want to use the arrow keys on the keypad. You can disable or 
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Cursor will not move using the arrow keys on the keypad.

Cause Solution

enable the Num Lock key in Computer Setup at Advanced > 
Device Options.

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the 
computer.

Shut down the computer using the keyboard.

Windows 10:

1. Press the Ctrl and Esc keys at the same time (or press the 
Windows logo key) to display the Start menu.

2. Use the arrow keys to scroll to and select the power icon at 
the top right on the menu, and then press Enter.

3. Use the arrow keys to select Shut Down, and then press 
Enter.

4. After the shutdown is complete, plug the mouse connector 
into the back of the computer (or the keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the 
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the internal 
components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make contact 
with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and clean 
the internal components with a mouse cleaning kit available from 
most computer stores.

Solving hardware installation problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional drive or 
expansion card. If you install a plug and play device, Windows automatically recognizes the device and 
configures the computer. If you install a non-plug and play device, you must reconfigure the computer after 
completing installation of the new hardware. In Windows, use the Add Hardware Wizard and follow the 
instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.
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WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system 
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect 
the power cord from the wall outlet and allow the internal system components to cool before touching.

Table 6-1  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected and 
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are 
unplugged.

Ensure that all cables are properly and securely connected and 
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn on 
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration, 
you did not accept them.

Reboot the computer and follow the instructions for accepting the 
changes.

A plug and play board may not automatically configure when 
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic settings 
for the board and choose a basic configuration that does not 
cause a resource conflict. You can also use Computer Setup to 
reconfigure or disable devices to resolve the resource conflict.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device available 
is selected for appropriate USB ports under Security > USB 
Security.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or memory 
modules were installed in the wrong location.

1. Review the documentation that came with the system to 
determine if you are using the correct memory modules and 
to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1 
must be installed before DIMM2.

2. Observe the beeps and LED lights on the front of the 
computer. Beeps and flashing LEDs are codes for specific 
problems.

3. If you still cannot resolve the issue, contact Customer 
Support.

Power LED flashes Red three times and then white two times.

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system board, 
you must unplug the computer power cord before attempting to 
reseat, install, or remove a DIMM module.
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Power LED flashes Red three times and then white two times.

Cause Solution

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1 
must be installed before DIMM2.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving network problems
Some common causes and solutions for network problems are listed in the following table. These guidelines 
do not discuss the process of debugging the network cabling.

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using 
Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Incorrect network driver. Check the network controller documentation for the correct driver 
or obtain the latest driver from the manufacturer’s Web site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device 
Manager for driver load and the Network Connections applet 
within Windows for link status.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using 
Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.
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Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into the 
correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network 
connector and that the other end of the cable is securely attached 
to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end of 
the cable.

Ensure that the cable and device at the other end are operating 
correctly.

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the resource 
settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not 
match current configuration.

Make sure the network drivers are loaded and that the driver 
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network and Sharing Center icon in the Control Panel 
and configure the network controller.

To access Control Panel in Windows 10, type control panel in 
the taskbar search box, and then select Control Panel from the 
list of applications.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the resource 
settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the 
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and conflicts 
with the embedded NIC.

Under the Computer Setup Advanced menu, change the resource 
settings for the board.
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Network controller stops working without apparent cause.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network 
connector and that the other end of the cable is securely attached 
to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the boot 
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present, and 
that the Remote System Installation Server contains the NIC 
drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving memory problems
If you encounter memory problems, some common causes and solutions are listed in the following table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on the 
Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must unplug the 
computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory. 
Otherwise, the computer will not boot the operating system.

NOTE: The memory count will be affected by configurations with the Management Engine (ME) enabled. The 
ME uses 8MB of system memory in single channel mode or 16 MB of memory in dual-channel mode to 
download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-party data storage, and 
other management functions.
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System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1 socket. Ensure that a memory module is installed in the DIMM1 or XMM1 
socket on the system board. This socket must be populated with a 
memory module.

Memory module is not the correct type or speed grade for the 
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for the 
computer. On some models, ECC and non-ECC memory modules 
cannot be mixed.

Out of memory error.

Cause Solution

You have run out of memory to run the application. Check the application documentation to determine the memory 
requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed correctly and 
that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs) are 
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add more 
memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps 
stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving CD-ROM and DVD problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the following table 
or to the documentation that came with the optional device.

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden in the 
Computer Setup utility.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Removable Media Boot is disabled in the Computer Setup utility. Run the Computer Setup utility and enable booting to removable 
media in Storage  > Storage Options. Ensure CD-ROM is enabled 
in Storage > Boot Order.

Network Boot is enabled in Computer Setup. Run the Computer Setup utility and disable Network Boot in 
Security > Network Boot.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in 
Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly 
installed device.

See reconfiguration directions in the Solving hardware installation 
problems on page 64 section. If the system still does not 
recognize the new device, check to see if the device is listed within 
Computer Setup. If it is listed, the probable cause is a driver 
problem. If it is not listed, the probable cause is a hardware 
problem.

If this is a newly installed drive, run the Computer Setup utility 
and try adding a POST delay under Advanced  > Power-On 
Options.

The device is attached to a SATA port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in Advanced > 
Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.
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Movie will not play in the DVD drive.

Cause Solution

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the 
emergency eject hole and push firmly. Slowly pull the tray out 
from the drive until the tray is fully extended, then remove 
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media is corrupt. Try different media to confirm whether media is valid.

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to 
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine the 
type of media being played. If the disc still does not start, read the 
other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most 
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

2. Restart the computer and let Windows detect the CD or DVD 
driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely 
between manufacturers.
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Solving USB flash drive problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following table.

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and enable USB ports in 
Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before 
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in 
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup utility. Run the Computer Setup utility and enable booting to removable 
media in Storage > Storage Options. Ensure USB is enabled in 
Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Flash drive is defective. Try a different flash drive.
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Solving front panel component problems
If you encounter problems with devices connected to the front panel, refer to the common causes and 
solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and 
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is connected 
to the device and one end is connected to a live outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that the USB ports are 
set to Enabled in Security > USB Security.

Solving Internet access problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the common 
causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up properly. Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work with 
your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED light on 
the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due to 
bad weather.

Try connecting to the Internet at a later time or contact your ISP. 
(If the cable/DSL service is connected, the “cable” LED light on the 
front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem and the 
computers’s RJ-45 connector. (If the connection is good, the “PC” 
LED light on the front of the cable/DSL modem will be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of information 
that a Web server can store temporarily with the Web browser. 
This is useful for having the browser remember some specific 
information that the Web server can later retrieve.)

Windows 10:

1. Type control panel in the taskbar search box, and then 
select Control Panel from the list of applications.
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Unable to connect to the Internet.

Cause Solution

2. Click Internet Options.

3. In the Browsing history section, click the Delete button.

4. Select the Cookies and website data check box and click the 
Delete button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.
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Solving software problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system, check to be 
sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the computer. 
See POST error messages and diagnostic front panel LEDs and 
audible codes on page 76 to determine possible causes.

See the Worldwide Limited Warranty for terms and conditions.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your version of 
Windows.

Verify that the software is certified by Microsoft for your version 
of Windows (see program packaging for this information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the 
computer.
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7 POST error messages and diagnostic front 
panel LEDs and audible codes

This appendix lists the error codes, error messages, and the various indicator light and audible sequences 
that you may encounter during Power-On Self-Test (POST) or computer restart, the probable source of the 
problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and non-
error text messages. If a POST error occurs, the screen will display the error message. To manually switch to 
the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12). The default mode is 
POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are 
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory test. 
Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish the 
schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 39.

POST numeric codes and text messages
This section covers those POST errors that have numeric codes associated with them. The section also 
includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Control panel message Description Recommended action

002-Option ROM Checksum Error System ROM or expansion board option ROM 
checksum.

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was recently added, 
remove it to see if the problem remains.

4. Clear CMOS. (See Password security and 
resetting BIOS on page 83.)

5. If the message disappears, there may be a 
problem with the expansion card.

6. Replace the system board.

003-System Board Failure DMA or timers. 1. Clear CMOS. (See Password security and 
resetting BIOS on page 83.)

2. Remove expansion boards.

3. Replace the system board.

005-Real-Time Clock Power Loss Invalid time or date in configuration memory. Reset the date and time under Control Panel 
(Computer Setup can also be used). If the 
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Control panel message Description Recommended action

RTC (real-time clock) battery may need to 
be replaced.

problem persists, replace the RTC battery. See 
the Removal and Replacement section for 
instructions on installing a new battery.

008–Microcode Patch Error Processor is not supported by the BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

009–PMM Allocation Error during MEBx 
Download

Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the computer, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

00A-Product Information Not Valid The product information programmed into the 
system board is missing or invalid.

Use Computer Setup to update this information.

00B-MEBx Module did not checksum correctly Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

00C-PMM Deallocation Error during MEBx 
Cleanup

Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

00D-Setup Error during MEBx Execution MEBx selection or exit resulted in a setup 
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.
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Control panel message Description Recommended action

00E-Inventory Error during MEBx Execution BIOS information passed to the MEBx resulted 
in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version.

3. If the error still persists, replace the 
system board.

00F-Interface Error during MEBx Execution MEBx operation experienced a hardware error 
during communication with the ME.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version.

3. If the error still persists, replace the 
system board.

100-Front Audio Not Connected Front audio cable has been detached or 
unseated from system board.

Reconnect or replace front audio cable.

2E1-MemorySize Error Memory amount has changed since the last 
boot (memory added or removed).

The system memory size is different from the 
last startup. The most common reason is the 
removal of memory from the system board. 
Press the F1 key to save the memory changes. 
If this message persists, verify that the 
memory modules are installed correctly.

2E2-Memory Error Memory module configuration failed during 
boot up.

1. Ensure memory modules are correctly 
installed.

2. Verify proper memory module type.

3. Remove and replace the identified faulty 
memory module(s).

4. If the error persists after replacing 
memory modules, replace the system 
board.

2E3-Incompatible Memory Module in Memory 
Socket(s) X, X, ...

A memory module in memory socket identified 
in the error message is missing critical SPD 
information, or is incompatible with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace with a supported module.

2E4-DIMM Configuration Warning The current memory configuration is not 
optimized.

Rearrange the DIMMs so that each channel has 
the same amount of memory.

2E5-ECC Memory Module Detected on 
Unsupported Platform

Recently added memory module(s) support ECC 
memory error correction.

1. If additional memory was recently added, 
remove it to see if the problem remains.

2. Check product documentation for 
memory support information.

2E6–Memory Not Configured Correctly for 
Proper MEBx Execution

DIMM1 is not installed. Make sure there is a memory module in the 
DIMM1 socket and that it is properly seated.

300–Configuration Change Warning The storage device configuration will be 
updated as shown.

Not applicable

301-Hard Disk 1: SMART Hard Drive Detects 
Imminent Failure

Hard drive is about to fail. (Some hard drives 
have a hard drive firmware patch that will fix an 
erroneous error message.)

1. Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test under using F2 Diagnostics 
when booting the computer.

2. Apply hard drive firmware patch 
if applicable. (Available at 
http://www.hp.com/support.)
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Control panel message Description Recommended action

3. Back up contents and replace hard drive.

302-Hard Disk 2: SMART Hard Drive Detects 
Imminent Failure

Hard drive is about to fail. (Some hard drives 
have a hard drive firmware patch that will fix an 
erroneous error message.)

1. Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test under using F2 Diagnostics 
when booting the computer.

2. Apply hard drive firmware patch 
if applicable. (Available at 
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

309 – 30C: Hard Disk 3–6: SMART Hard Drive 
Detects Imminent Failure

Hard drive is about to fail. (Some hard drives 
have a hard drive firmware patch that will fix an 
erroneous error message.)

1. Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test under using F2 Diagnostics 
when booting the computer.

2. Apply hard drive firmware patch 
if applicable. (Available at 
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

3F0–Boot Device Not Found Boot device not found. Insert boot device or load operating system.

3F1–Hard Disk 1 Error Hard disk 1 error. 1. Check and/or replace cables.

2. Clear CMOS. (See Password security and 
resetting BIOS on page 83.)

3. Replace the hard disk drive.

3F2–Hard Disk 2 Error Hard disk 2 error. 1. Check and/or replace cables.

2. Clear CMOS. (See Password security and 
resetting BIOS on page 83.)

3. Replace the hard disk drive.

400-Serial Port A Address Conflict Detected Both external and internal serial ports are 
assigned to the same resources.

1. Remove any serial port expansion cards.

2. Clear CMOS. (See Password security and 
resetting BIOS on page 83.)

3. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

401-Serial Port B Address Conflict Detected Both external and internal serial ports are 
assigned to the same resources.

1. Remove any serial port expansion cards.

2. Clear CMOS. (See Password security and 
resetting BIOS on page 83.)

3. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

402-Serial Port C Address Conflict Detected Both external and internal serial ports are 
assigned to the same resources.

1. Remove any serial port expansion cards.

2. Clear CMOS. (See Password security and 
resetting BIOS on page 83.)

3. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

403-Serial Port D Address Conflict Detected Both external and internal serial ports are 
assigned to the same resources.

1. Remove any serial port expansion cards.

2. Clear CMOS. (See Password security and 
resetting BIOS on page 83.)
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Control panel message Description Recommended action

3. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

419-Out of Memory Space for Option ROMs Recently added PCI expansion card contains an 
option ROM too large to download during POST.

▲ If a PCI expansion card was recently 
added, remove it to see if the problem 
remains.

41A-Front USB1/USB2 Not Connected Front USB cable has been detached or unseated 
from system board.

Reconnect or replace front USB cable.

41B-Device in PCI Express Slot Failed To 
Initialize

There is an incompatibility or problem with a 
PCIe device and the system or PCIe link could 
not be configured to a valid bus width or speed.

Try rebooting the system. If the error reoccurs, 
the device may not work with this system

43A-USB Type-C I2C Not Connected Cable is required between I2C on card and USB-
C on the system board.

Install cable between I2C on card and USB-C on 
the system board.

43B-More Than One USB type-C Cards Are 
Installed

More than one USB type-C card is installed. Remove USB type-C card so only one is 
installed.

500–BIOS Recovery A system BIOS recovery has occurred. Not applicable.

70x-Wireless Mode Not Supported The system has detected a wireless module 
installed in the system that is not supported 
and has been disabled.

Replace with a supported module.

800-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

801-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer 
turned off.

2. Ensure that none of the keys are 
depressed.

3. Replace the keyboard.

4. Replace the system board.

900-CPU Fan Not Detected CPU fan is not connected or may have 
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

901-Chassis, Rear Chassis, or Front Chassis Fan 
not Detected

Chassis, rear chassis, or front chassis fan is not 
connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front 
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front 
chassis fan.

903-Computer Cover Has Been Removed Since 
Last System Startup

N/A

904-SATA Cabling Error One or more SATA devices are improperly 
attached. For optimal performance, the SATA 0 
and SATA 1 ports should be used for hard drives 
before other ports.

Ensure SATA connectors are used in ascending 
order. For one device, use SATA 0. For two 
devices, use SATA 0 and SATA 1. For three 
devices, use SATA 0, SATA 1, and SATA 2.
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Control panel message Description Recommended action

90B-Fan Failure The system has detected that a cooling fan is 
not operating correctly.

1. Reseat fan.

2. Reseat fan cable.

3. Replace fan.

90D-System Temperature Thermal shutdown occurred. The system BIOS 
has detected your machine was previously shut 
down to avoid overheating. Overheating may 
occur if the cooling vents are blocked or the 
operating temperature exceeds the system 
specifications. The machine should return to 
normal operation once the situation is resolved.

Make sure system has proper airflow.

90E-Power Supply Fan Not detected Power supply fan is not connected or may have 
malfunctioned.

1. Reseat power supply fan.

2. Reseat fan cable.

3. Replace power supply fan.

910–Filter Warning Airflow filter is dirty. Replace the airflow filter.

Interpreting system validation diagnostic front panel LEDs and 
audible codes

During the system validation phase that occurs at system startup, the BIOS validates the functionality of the 
following subsystems and conditions:

● AC adapter

● System board power

● Processor failure

● BIOS corruption

● Memory failure

● Graphics failure

● System board failure

● BIOS authentication failure

If an error is detected, specific patterns of long and short blinks, accompanied by long and short beeps (where 
applicable) are used to identify the error. These patterns will make up a two part code:

● Major – the category of the error

● Minor – the specific error within the category

NOTE: Single beep/blink codes are not used.

Number of long beeps/blinks Error category

1 Not used

2 BIOS

3 Hardware
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4 Thermal

5 System board

Patterns of blink/beep codes are determined by using the following parameters:

● 1 second pause occurs after the last major blink.

● 2 second pause occurs after the last minor blink.

● Beep error code sequences occur for the first 5 iterations of the pattern and then stop.

● Blink error code sequences continue until the computer is unplugged or the power button is pressed.

NOTE: Not all diagnostic lights and audible codes are available on all models.

The red LED blinks to represent the major error category (long blinks). The white LED blinks to represent the 
minor error category (short blinks). For example, ‘3.5’ indicates 3 long red blinks and 5 short white blinks to 
communicate the processor is not detected.

Category Major/minor code Description

BIOS 2.2 The main area (DXE) of BIOS has become corrupted and there is no recovery 
binary image available.

 2.3 The embedded controller policy requires the user to enter a key sequence.

 2.4 The embedded controller is checking or recovering the boot block.

Hardware 3.2 The embedded controller has timed out waiting for BIOS to return from 
memory initialization.

 3.3 The embedded controller has timed out waiting for BIOS to return from 
graphics initialization.

 3.4 The system board displays a power failure (crowbar).*

 3.5 The processor is not detected.*

 3.6 The processor does not support an enabled feature.

Thermal 4.2 A processor over temperature condition has been detected.*

 4.3 An ambient temperature over temperature condition has been detected.

 4.4 An MXM over temperature condition has been detected.

System board 5.2 The embedded controller cannot find valid firmware.

 5.3 The embedded controller has timed out waiting for the BIOS.

 5.4 The embedded controller has timed out waiting for BIOS to return from 
system board initialization.

 5.5 The embedded controller rebooted the system after a possible lockup 
condition had been detected through the use of a System Health Timer, 
Automated System Recovery Timer, or other mechanism.

* Indicates hardware triggered event; all other events are controlled by the BIOS.
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8 Password security and resetting BIOS

This computer supports security password features, which can be established through the Computer Setup 
Utilities menu.

This computer supports two security password features that are established through the Computer Setup 
Utilities menu: administrator password and power-on password. When you establish only an administrator 
password, any user can access all the information on the computer except Computer Setup. When you 
establish only a power-on password, the power-on password is required to access Computer Setup and any 
other information on the computer. When you establish both passwords, only the administrator password will 
give you access to Computer Setup.

When both passwords are set, the administrator password can also be used in place of the power-on 
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget one or both passwords, you can clear all passwords by powering off the system, opening the 
cover, temporarily removing the PSWD jumper, and booting once. This will erase the administrator and 
power-on passwords. You must restore the jumper to create new passwords.

CAUTION: Pushing the CMOS button with power removed will reset the BIOS settings to factory defaults. It 
may be useful to back up the BIOS settings or save them as custom defaults before resetting them in case 
they are needed later. Back up can be performed in Computer Setup or using the BiosConfigUtility tool 
available from www.hp.com. 

Resetting the password/BIOS jumper
CAUTION: Stringent security is a mode where there is no physical bypass of the password function. If 
enabled, removing the password jumper will be ignored. To enable this mode, change the security setting 
Clear Password Jumper in Password Policies to Ignore.

If you lose or forget the password when in stringent security mode, the system can only be reset by System 
Management Command. This is a way for HP Service and Support to provide a secure method to access the 
BIOS and command a password reset for a specifically identified unit under the direction of the owner. This 
scenario may not be covered under warranty.

To prevent needing a customer service event to restore access to the system, record your configured 
administrator and power-on passwords in a safe place away from your computer.

Resetting the password jumper will reset BIOS values to factory defaults. It is important to back up the 
computer BIOS settings before resetting them in case they are needed later. Back up is easily done through 
Computer Setup. See Computer Setup (F10) Utility on page 39 for information on backing up the BIOS 
settings.

NOTE: You will receive POST error messages after clearing BIOS and rebooting advising you that 
configuration changes have occurred. Use Computer Setup to reset any special system setups along with the 
date and time.

On Intel systems with advanced manageability features, resetting the BIOS will also partially unprovision AMT.

To disable the power-on or administrator password features, or to clear the power-on password, 
administrator password, or BIOS, complete the following steps:
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1. Shut down the operating system properly, then turn off the computer and any external devices, and 
disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any residual 
power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet, and allow the internal system components to cool 
before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in 
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object. See the Safety & Regulatory Information guide for more information.

3. Remove the access panel.

4. Locate the header and jumper.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating the 
password jumper and other system board components, see the system board components image at 
System board callouts on page 31.

5. Remove the jumper from pins 1 and 2.

6. Place the jumper on either pin 1 or 2, but not both, so that it does not get lost.

7. Replace the access panel and reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to start. This clears the current 
passwords and disables the password features.

9. Shut down the computer, unplug the power, and disconnect the external equipment.

10. Remove the access panel.

11. Place the jumper on pins 1 and 2.

12. Replace the access panel.

13. Reconnect the external equipment and plug in the computer.
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9 Using HP PC Hardware Diagnostics (UEFI)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic 
tests to determine whether the computer hardware is functioning properly. The tool runs outside the 
operating system so that it can isolate hardware failures from issues that are caused by the operating system 
or other software components.

When HP PC Hardware Diagnostics (UEFI) detects a failure that requires hardware replacement, a 24-digit 
Failure ID is generated. This ID can then be provided to support to help determine how to correct the problem.

To start HP PC Hardware Diagnostics (UEFI), follow these steps:

1. Turn on or restart the computer, and quickly press esc

Turn on or restart the computer, and quickly press esc

2. Press F2.

The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading 
HP PC Hardware Diagnostics (UEFI) to a USB device on page 85.

b. Hard drive

c. BIOS

3. When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the 
on-screen instructions.

NOTE: If you need to stop a diagnostic test, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only, and you 
must use a Windows computer to download and create the HP UEFI support environment because only .exe 
files are offered.

There are two options to download HP PC Hardward Diagnostics to USB device.

Download the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. In the HP PC Hardware Diagnostics section, click the Dowload link, and then select Run.

Download any version of UEFI for a specific product 

1. Go to http://www.hp.com/support, and then select your country. The HP Support page is displayed. .

2. Click Drivers & Downloads.

3. Use the categories listed to find your product.

– or –
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Click Find Now to let HP automatically detect your product.

4. Select your computer, and then select your operating system.

5. In the Diagnostic section, follow the on-screen instructions to select and download the UEFI version you 
want.
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10 System backup and recovery

Backing up, restoring, and recovering in Windows 10
This section provides information about the following processes. The information in the section is standard 
procedure for most products.

● Creating recovery media and backups

● Restoring and recovering your system

For additional information, refer to Help and Support.

▲ Type help in the taskbar search box, and then select Help and Support.

Creating recovery media and backups

The following methods of creating recovery media and backups are available on select products only. Choose 
the available method according to your computer model.

● Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This 
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall 
the original operating system in cases where the hard drive is corrupted or has been replaced. For 
information on creating recovery media, see Creating HP Recovery media (select products only) 
on page 87. For information on the recovery options that are available using the recovery media, see 
What you need to know before you get started on page 89.

● Use Windows tools to create system restore points and create backups of personal information.

For more information, see Using Windows tools on page 88.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

Creating HP Recovery media (select products only)

If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu, 
select File Explorer.

● If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery 
media for your system from support. See the Worldwide Telephone Numbers booklet included with the 
computer. You can also find contact information on the HP website. Go to http://www.hp.com/support, 
select your country or region, and follow the on-screen instructions.

You can use Windows tools to create system restore points and create backups of personal information, 
see Using Windows tools on page 88.

● If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery 
Manager to create recovery media after you successfully set up the computer. HP Recovery media can be 
used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls the 
original operating system and software programs that were installed at the factory and then configures 
the settings for the programs. HP Recovery media can also be used to customize the system or restore 
the factory image if you replace the hard drive.
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◦ Only one set of recovery media can be created. Handle these recovery tools carefully, and keep 
them in a safe place.

◦ HP Recovery Manager examines the computer and determines the required storage capacity for 
the media that will be required.

◦ To create recovery discs, your computer must have an optical drive with DVD writer capability, and 
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use 
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray) 
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a high-
quality blank USB flash drive.

◦ If your computer does not include an integrated optical drive with DVD writer capability, but you 
would like to create DVD recovery media, you can use an external optical drive (purchased 
separately) to create recovery discs. If you use an external optical drive, it must be connected 
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external 
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs 
for your computer from HP. See the Worldwide Telephone Numbers booklet included with the 
computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

◦ Be sure that the computer is connected to AC power before you begin creating the recovery media.

◦ The creation process can take an hour or more. Do not interrupt the creation process.

◦ If necessary, you can exit the program before you have finished creating all of the recovery DVDs. 
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery 
Manager, you will be prompted to continue.

To create HP Recovery media:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 89.

Using Windows tools

You can create recovery media, system restore points, and backups of personal information using Windows 
tools.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see Help and Support.

▲ Type help in the taskbar search box, and then select Help and Support.

Restore and recovery

There are several options for recovering your system. Choose the method that best matches your situation 
and level of expertise:

IMPORTANT: Not all methods are available on all products.

● Windows offers several options for restoring from backup, refreshing the computer, and resetting the 
computer to its original state. For more information see Help and Support.
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▲ Type help in the taskbar search box, and then select Help and Support.

● If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/ 
or applications option (select products only) of HP Recovery Manager to reinstall the individual 
application or driver.

▲ Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers 
and/or applications, and then follow the on-screen instructions.

● If you want to recover the Windows partition to original factory content, you can choose the System 
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media. 
For more information, see Recovering using HP Recovery Manager on page 89. If you have not already 
created recovery media, see Creating HP Recovery media (select products only) on page 87.

● On select products, if you want to recover the computer's original factory partition and content, or if you 
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more 
information, see Recovering using HP Recovery Manager on page 89.

● On select products, if you want to remove the recovery partition to reclaim hard drive space, HP 
Recovery Manager offers the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition (select products only) on page 90.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the 
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery 
partition (select products only). If you have not already created recovery media, see Creating HP Recovery 
media (select products only) on page 87.

What you need to know before you get started

● HP Recovery Manager recovers only software that was installed at the factory. For software not provided 
with this computer, you must either download the software from the manufacturer's website or reinstall 
the software from the media provided by the manufacturer.

IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct 
computer issues.

● HP Recovery media must be used if the computer hard drive fails. If you have not already created 
recovery media, see Creating HP Recovery media (select products only) on page 87.

● To use the Factory Reset option (select products only), you must use HP Recovery media. If you have not 
already created recovery media, see Creating HP Recovery media (select products only) on page 87.

● If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not 
work, you can obtain recovery media for your system from support. See the Worldwide Telephone 
Numbers booklet included with the computer. You can also find contact information from the HP 
website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen 
instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before 
beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

NOTE: Only the options available for your computer display when you start the recovery process.
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● System Recovery—Reinstalls the original operating system, and then configures the settings for the 
programs that were installed at the factory.

● Factory Reset—Restores the computer to its original factory state by deleting all information from the 
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that 
was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a 
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

1. Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery 
Environment.

- or -

Press f11 while the computer boots, or press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does 
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer 
boot order. See Changing the computer boot order on page 90.

3. Follow the on-screen instructions.

Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is 
the order of devices listed in BIOS where the computer looks for startup information. You can change the 
selection to an optical drive or a USB flash drive.

To change the boot order:

1. Insert the HP Recovery media.

2. Access BIOS.

Restart the computer, quickly press esc, and then press f9 for boot options.

3. Select the optical drive or USB flash drive from which you want to boot.

4. Follow the on-screen instructions.

Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.
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IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery 
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition, 
create HP Recovery media; see Creating HP Recovery media (select products only) on page 87.

NOTE: The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.
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A Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature on 
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power 
supplies on those computers that do not have external power switches are equipped with internal switches 
that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you 
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the 
computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation in the 
country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal voltage 
rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord must be 
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon it or 
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits 
from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in 
any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and 
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole 
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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B Statement of Volatility

HP confirms that commercial desktop systems contain DDR3 volatile memory (memory amount depends on 
the customer configuration). In addition, the motherboard in the condition originally shipped without 
subsequent modification or the addition or installation of any applications, features, or functionality, 
contains the following nonvolatile memory: Real Time Clock battery backed-up configuration memory (256 
Bytes), DIMM Serial Presence Detect (SPD) configuration data (256 Bytes per module, 128 Bytes 
programmable), Serial Peripheral Interface (SPI) ROM for System BIOS (8M Bytes) and Serial Peripheral 
Interface (SPI) ROM for System FireBird (Sure Start) (8M Bytes) and Super I/O’s: masked keyboard ROM (overall 
2K Bytes). In addition, these units contain a Trusted Platform Module (TPM) that contains 16K Bytes of non-
volatile memory for user data. The volatile memory will not hold any user data once power has been removed 
for 30 seconds or longer.

To restore the non-volatile memory:

1. Download the latest BIOS (system ROM) from the HP website.

2. Follow the instructions to flash the BIOS that are found on the website.

Flashing the BIOS will reset it back to factory settings.

3. Turn on the system, and while system is powering on, and after the HP splash screen, press the F10 key 
to enter BIOS setup screen.

4. Select Security > System Security from the main menu. If the Embedded Security Device Support 
option is set to “Disable”, skip to step 7.

5. To erase all security keys from the TPM:

Under Embedded Security Device in the System Security menu, configure Reset to Factory Settings to 
Reset.

NOTE: Although the TPM security keys will be cleared, data in the non-volatile memory indices may 
not be. Data stored in these indices should not contain security sensitive information. If an application 
locks down and secures the non-volatile indices, these indices cannot be cleared.

6. Press F10 to accept changes.

7. To clear the secure boot key database:

a. Enter the F10 setup utility.

b. Go to the Security menu.

c. Select Secure Boot Configuration.

d. In the Key Management section, select clear Secure boot keys.

e. Use space key to select clear.

f. Press the F10 key to accept changes.

g. From the main menu select File > Save Changes and Exit.

8. If the Ownership Tag or Asset Tag is set, manually clear it under Security > System Ids.

9. Select File > Save Changes and Exit.
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10. To clear the Setup or Power-On passwords if set, and clear any other settings, power down the computer 
and remove the AC power cord and the computer hood.

11. Locate the green two pin password jumper on header E49 (labeled PSWD) and remove it.

12. Remove the AC power, wait 10 seconds until the unit AC power has drained out, then press the clear 
CMOS button. This is typically a yellow push button (labeled CMOS).

13. Replace the hood and AC power cord and turn the computer on. The passwords are now cleared and all 
other user-configurable, non-volatile memory settings are reset to their factory default values.

14. Enter the F10 setup utility.

15. Select File > Default Setup > Restore Factory Settings as Default. This will set the default settings 
back to the factory defaults.

16. Select File > Apply Defaults and Exit.

17. Shut down the computer, remove the AC power cord and place the (blue/green) jumper back on header 
E49. Replace the computer hood and power cord.

If Absolute Persistence Module is enabled on the computer, see the service provider for instructions to disable 
the feature.
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C Specifications

SFF specifications
Table C-1  Specifications

Chassis (in the desktop position)

Height

Width

Depth

4.00 in

12.5 in

15.0 in

102 mm

318 mm

381 mm

Approximate Weight 15.5 lb 7.05 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct sustained 
sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options installed.

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

Power supply 180W, up to 85% efficient, active PFC, ENERGY STAR® 
6.0/6.1, Bronze Power Supply Unit
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